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1. Introduction  

Thank you for choosing the Em50 data logger series.  These
data loggers are designed and suited for field research and
commercial agriculture. This manual will explain the Em50’s
capabilities and functions.

NOTE: Except where specified, all functions and specifica-
tions relating to the Em50 also relate to the Em50R and the
Em50G.  

Customer Support
If you ever need assistance with your Em50, or if you just have
questions or feedback, there are several ways to contact us:

Phone:
1-800-755-2751 (Toll free to customers in US and Canada)
1-509-332-2756  (for international customers)

Customer service representatives are available to speak with
you Monday thru Friday, between 8am and 5pm Pacific time. 

Fax:  
1-509-332-5158

E-mail: 
support@decagon.com or sales@decagon.com

If contacting us by email or fax, please include as part of your
message your instrument’s serial number, your name, address,
phone, and fax number.  
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You can also send feedback to Decagon using ECH2O Utility’s
“Send Feedback to Decagon” feature. See Appendix B for more
information.

NOTE:  If you purchased your Em50 through a distributor,
please contact them for assistance.

Software Downloads and Updates
Go to www.Decagon.com/support/downloads if you need to
download firmware updates, software updates and/or drivers . 

Warranty
All Decagon products have a 30-day satisfaction guarantee and
the Em50 has a one-year warranty.

Seller’s Liability
Seller warrants new equipment of its own manufacture against
defective workmanship and materials for a period of one year
from date of receipt of equipment (the results of ordinary wear
and tear, neglect, misuse, accident and excessive deterioration
due to corrosion from any cause are not to be considered a
defect); but Seller’s liability for defective parts shall in no
event exceed the furnishing of replacement parts F.O.B. the
factory where originally manufactured. Material and equip-
ment covered hereby which is not manufactured by Seller shall
be covered only by the warranty of its manufacturer. Seller
shall not be liable to Buyer for loss, damage or injuries to per-
sons (including death), or to property or things of whatsoever
kind (including, but not without limitation, loss of anticipated



      Em50/Em50R/Em50G Operator’s Manual
1. Introduction

3

profits), occasioned by or arising out of the installation, opera-
tion, use, misuse, nonuse, repair, or replacement of said mate-
rial and equipment, or out of the use of any method or process
for which the same may be employed. The use of this equip-
ment constitutes Buyer’s acceptance of the terms set forth in
this warranty. There are no understandings, representations, or
warranties of any kind, express, implied, statutory or otherwise
(including, but without limitation, the implied warranties of
merchantability and fitness for a particular purpose), not
expressly set forth herein.

Specifications
Input Ports:  5, 12-bit analog or 32-bit digital 
Port type: 3.5mm “stereo jack” connector
Data Storage: 1MB (36,800 scans for all 5 ports)
Memory type: Non-Volatile Flash 
Battery capacity:5 AA Alkaline or Lithium batteries
Enclosure: Weatherproof, impact and UV-resistant polymer
Enclosure rating: IP55, NEMA3R
Operating environment: 60° to -40°C, up to 100% RH
Communication: Dedicated serial port 3.5mm stereo jack for 

use with the Decagon USB Cable Adapter (UCA).
Radio (Em50R models):

902 - 928 MHz ISM North America
915 - 928 MHz ISM Australia, New Zealand, Israel
2.4 GHz ISM Worldwide 

Cellular (Em50G): GSM/GPRS Cellular technology.  Cellular
service and data hosting service provided by Decagon 
Devices.



Em50/Em50R/Em50G Operator’s Manual
2. Em50/Em50R/Em50G

4

2. Em50/Em50R/Em50G  

Em50 Logger Series Overview

Introduction
The ECH2O System is made of data loggers, sensors, teleme-
try, and software that help you measure soil moisture and other
environmental parameters accurately and cost effectively.
Decagon’s innovative sensors are the heart of the system.
Decagon also designed the system to be very easy to use (no
programming needed). 

About the Em50 Logger Series. The Em50 is a 5-port, self-
contained data logger especially suited for field research and
commercial agriculture. The Em50 logger series includes three
models: the Em50, the Em50R and the Em50G. These devices
are housed in a weather-resistant enclosure, making them suit-
able for long-term outdoor operation. 

Em50
The Em50 is the basic logger.  The communication with this
model is through a stereo to USB or stereo to Serial cable to a
PC or mobile handheld device.

Em50R
The Em50R includes a spread-spectrum radio telemetry mod-
ule. The radio module is available in long-range 900 MHz and
2.4 GHz frequencies. Use the telemetry in energy efficient
transmit mode or  two-way mode. (See Chapter 6 for more
information on telemetry.)
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Em50G
The Em50G includes GSM/GPRS (Global System for Mobile
communications/General Packet Radio Service) cellular mod-
ule to allow environmental measurement data available over
the internet.  Decagon partners with a provider of global cellu-
lar data service to make data transmission and maintenance
easy and inexpensive.  Measurements from the Em50G are
sent wirelessly to Decagon's internet server and are available
for download using DataTrac 3 software or Em50G Down-
loader software.  

Em50 Compatible Sensors
You can use the Em50 to log data for almost all of the sensors
that Decagon sells (excluding the UMS and thermal sensors).
Please see our website (www.decagon.com) or our catalog for
an up-to-date list of supported sensors. 

Software  
The Em50 series gives you two software options for working
with your hardware and collected data. Choose one or both
packages to fit your needs. Download the latest versions of
these programs at www.decagon.com/support/downloads.  

ECH2O Utility
ECH2O Utility is free software that is included with your pur-
chase. It provides a simple way to connect to and configure
your loggers. The ECH2O Utility makes downloading and pro-
cessing your measured data fast and easy. 

• Connect to Em50 loggers directly or with radio telemetry.

• Set all logger configuration parameters with visual controls. 

• Make real-time sensor measurements (scan sensors). 
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• Create Excel or text files with raw or processed data. 

• Create configuration and data files for use with
DataTrac. 

DataTrac 3
DataTrac 3 is the premier Em50 series system software designed
to help you organize and visualize your measurement data.
DataTrac 3 transforms endless columns and rows of raw data
into meaningful, easily-interpreted graphs. DataTrac 3 comes
with the Em50 system as a 30-day trial version.  If you would
like to continue to use DataTrac 3, contact Decagon to purchase
a DataTrac 3 registration code.  With DataTrac 3 you can:

• Explore trends and relationships in real time. 

• You can adjust date ranges, add or subtract data from
specific sensors, and change target bands to illustrate and
explore your findings. Powerful charting engine shows
data graphically. 

• Use DataTrac 3’s Growing Tools to combine data streams
and track meaningful indicators. For example, plot vapor
pressure deficit instead of just temperature and humidity.
Or track growing degree days, plant available water, pore
water EC, etc.

• Use the “virtual sensor” tool to add information you wish
you had. For example, you can measure precipitation on
just one logger and make that data stream a “virtual sen-
sor” on every logger at that site.

• Automatically collect data from your Em50G and
Em50R loggers. All data—including manually collected
data--will be automatically organized and added to your
files chronologically.
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• Watch your data in real time. DataTrac 3 updates auto-
matically while it’s running and every time it starts up. 

• Add notes and ideas to the data stream. Comments and
reminders can help you make sense of a growing sea-
son’s worth of data later. 

• Educate and inform your team efficiently. DataTrac 3’s
graphics reduce the time and expertise needed to under-
stand soil moisture data.

• With this much data, you can spend enormous amounts
of time scrolling through looking for answers. DataTrac 3
lets you explore your data graphically and discover
quicker answers and unexpected insights.

ECH2O Utility Mobile
ECH2O Utility Mobile is designed to bring the usefulness of
ECH2O Utility to Windows powered mobile devices or hand-
held computers (PDA). Use this software and your PDA in the
field instead of your expensive laptop. This software will con-
figure your logger, download data, and make real-time sensor
measurements. Like the desktop version, ECH2O Utility
Mobile allows you to: 

• Connect directly or with radio telemetry to Em50 loggers.

• Set all logger configuration parameters with visual controls. 

• Make real-time sensor measurements (scan sensors). 

• Creates configuration and data files for use with
DataTrac 3. 

• Creates data files for use with ECH2O Utility. 

ECH2O Utility Mobile works with most Windows PDAs,
including the HP iPAQ. Decagon Recommends using the Juni-
per Systems Archer field PC (available from Decagon). This
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ultra-rugged mobile device is designed to work in field condi-
tions where typical PDA hardware will fail. Please see the
ECH2O Utility Mobile manual for more information on system
requirements to use your PDA with the ECH2O System.

Em50G Downloader
The Em50G Downloader is a free software that allows you to
download Em50G data in Microsoft Excel format if you do not
have DataTrac 3.  See Chapter 5 for more information about
the Em50G Downloader.

Em50 Series Data Logging Scheme
The Em50 will not make sensor measurements until you set a
measurement interval. You also need to configure the Em50 ports
with the type of sensor plugged into each port. You can set these
values using the software described in the previous section.

Em50 Measurement Interval
The measurement interval controls how often data is recorded
in the Em50’s internal data storage. The interval you choose
applies to all 5 ports on the Em50, therefore, it is not possible
to have one port measuring sensors more or less frequently
than another port. 

The measurement interval works relative to the Em50’s inter-
nal real-time, 24-hour clock. For example, when choosing a
measurement interval of 120 minutes, the Em50 will store data
every two hours, on the hour. The resulting data will show sen-
sor measurements hourly at 12:00 a.m., 2:00 a.m.,..., 10:00
p.m. Choosing a measurement interval greater than 720 results
in one set of data stored per day. For most applications, a mea-
surement interval of 60 or 120 minutes is appropriate.



      Em50/Em50R/Em50G Operator’s Manual
2. Em50/Em50R/Em50G

9

NOTE:  Setting the Em50 measurement interval to zero turns
off sensor measurement and data storage. 

For most sensor types, the Em50 makes a measurement from
each of the 5 sensor ports every 60 seconds, regardless of the
measurement interval value. When the Em50’s internal clock
reaches the user-programmed measurement interval, the Em50
stores the average of all the 60-second sensor readings taken
since the last storage interval. Therefore, if you set the mea-
surement interval to 60, the Em50 will actually store an aver-
age of the past 60 sensor readings. If you choose an interval of
1440, the Em50 will store one value that represents the average
sensor value for the entire 24-hour period.

NOTE:  The Em50G supports 5 minutes as the minimum value for
the measurement interval setting. 

Data Storage Format
The Em50 stores “raw” data for each sensor. The stored values
are not in millivolt units. Please review your individual sensors
operators manual or visit our website (www.decagon.com) for
up to date equations to convert raw data to meaningful sensor
values.

How the Em50 Stores Data  
The Em50 stores data for all five sensor ports for each mea-
surement interval. If no sensor is connected to one or more of
the logger’s ports, the Em50 will store a “0” for that port. The
Em50’s data memory is non-volatile flash. Removing the bat-
teries or performing a system reset will not erase your data.
However, it will reset the clock in the data logger.  To reset the
clock to the correct time, simply connect your Em50 to a com-
puter or handheld device running ECH2O software.
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Data Storage Size  
The Em50 stores more than 36,800 data scans. When the log-
ger has filled its data memory, it begins overwriting the oldest
data in the memory. 

Measurement Span 
Depending on the set measurement interval, the Em50 can read
for several weeks to several years before its memory has filled.
When you set up your Em50 using ECH2O Utility, the soft-
ware will display how many days of data the Em50 will hold
based on the measurement interval that you have chosen.  You
can determine how many days of data your Em50 will hold by
dividing the size of the data memory (36,864 scans) by the
measurement interval. For example, an Em50 set on an hourly
measurement interval will store 1,500 days, or about 4 years,
worth of data. An Em50 set to five minutes will store data for
125 days, or about four months.
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3. Setup and Installation 

Installing the Batteries

The Em50s are shipped with a new set of AA alkaline batter-
ies. Open the case and install the batteries in the proper orienta-
tion as indicated in the battery locations. After installing the
batteries, press the silver Reset button located directly above
the batteries.

NOTE: Installing or changing the batteries in your Em50
resets the internal real-time clock. You must connect to your
Em50 using any ECH2O System software to reset the logger’s
clock. If you don’t set the logger’s clock, the time and date
associated with each measurement will be incorrect.
 
The Em50 is powered by 5 AA-size Alkaline batteries. With
the radio or cellular modules disabled, a set of Alkaline or
Lithium batteries can last for several years. The battery life for
Em50Gs and Em50Rs varies depending on how the transmis-

Batteries

button
Status
lights

RESET TEST
button
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sion is setup. (See Chapter 6.) Battery power in the Em50R and
Em50G can last from six months to over a year.

You can check the battery level status when the Em50 is con-
nected using any ECH2O software. When the battery life indi-
cator shows that your Em50’s batteries are less than 5%, you
should replace them.

Reset Button   
All Em50 logger types have a “RESET” button. If your logger
doesn't respond to connection attempts or doesn't appear to be
working, press the reset button. This will reboot the logger and
the “STATUS” light will turn on momentarily. The internal
data storage of the logger is non-volatile so you will not loose
data or settings if you press the reset button.

Em50R STATUS Light
The green “STATUS” light indicates the current status of your
Em50R logger. 

• A short, single blink every 5 seconds indicates the
Em50R is configured to log sensor data. The light doesn't
blink if the logger's measurement interval is set to 0 or
"Off".

• A slow on/off blink indicates the Em50R is connected to
an active serial port.

• A rapid continuous blink indicates the logger's date and
time are not set correctly. This can happen when the bat-
teries have been disconnected. You must connect to your
Em50R using any ECH2O System software to reset the
logger's internal clock. The logger will stop error blink-
ing when the date is reset or after 2 minutes have elapsed
(to preserve battery power).
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Em50/Em50G Status Lights
The “OK” (green) and “ERROR” (red) lights indicate the cur-
rent status of your Em50/Em50G logger. 

• The lights indicate the status of the logger’s self test
function (see below).

• A short, single blink of the “OK” (green) light every 5
seconds indicates the Em50/Em50G is configured to log
sensor data. The light doesn't blink if the logger's mea-
surement interval is set to 0 or “Off”.

• The “OK” (green) light blinks slowly on/off blink indi-
cates the logger is connected to an active serial port or
the cellular module is powered on.

• The “OK” (green) light pulses when the Em50G is
actively sending data over the cellular network.

• The “ERROR” (red) light blinks continuously to indicate
the logger's date and time are not set correctly. This can
happen when the batteries have been disconnected. You
must connect to your Em50/Em50G using any ECH2O
System software to reset the logger’s internal clock. The
logger will stop error blinking when the date is reset or
after 2 minutes have elapsed (to preserve battery power).
Pressing the “TEST” button may also reset the loggers
clock by using the time of the cellular network if the con-
nected network supports time information.

Em50/Em50G TEST Button
The Em50/Em50G logger has a TEST button to perform basic
functionality testing. When you press the TEST button, the
logger performs several checks on internal systems and
attempts a communication session over the cellular network, if
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an Em50G. The logger uses the status lights during the test as
follows:

• Both the “OK” (green) and “ERROR” (red) lights blink
slowly while the Em50G is performing the tests. Please
be patient. It can take as much as 60 seconds or more to
finish the cellular communication tests in the Em50G.

• The “OK” (green) light pulses when the Em50G is
actively sending data over the cellular network.

• A solid “OK” (green) light indicates the internal tests
passed and there was successful communication over the
cellular network to the Decagon Data Service. The
Em50G leaves the light on for approximately 20 seconds.

• A solid “ERROR” (red) light indicates an error in the
logger or in communicating to the Decagon Data Service.
Please use the Communication Test feature in ECH2O
Utility to find the specific error.

Installing Software
The ECH2O Utility and DataTrac 3 software (installation cd
is attached to the cover of this manual) allows you to collect
and manage data from your device. The Em50G Downloader
software is also included if you have an Em50G.

NOTE:  This manual documents ECH2O Utility. Most tasks
that can be performed using the ECH2O Utility can also be
accomplished using DataTrac 3 or ECH2O Utility Mobile. For
more information about using DataTrac 3 or ECH2O Utility
Mobile, please refer to their respective manuals. 

To install ECH2O Utility, DataTrac 3, or Em50G software,
place the CD in your CD drive, and wait for it to auto-launch.
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If it doesn’t launch, go to My Computer, select your CD drive,
and click on the “setup.exe” file.  A driver for the accompany-
ing USB cable can also be installed at this time.

Occasionally, new versions of ECH2O System software will
become available on Decagon’s website. They can be accessed
at www.decagon.com/support/downloads.

You can find your current software version in the “About”
option of the Help menu in the ECH2O Utility and DataTrac 3.
If you are connected to the internet, select “Check for Updates”
in the Help menu to see if there is a newer version available.

Decagon USB Cable Adapter (UCA) Driver Installation
You must install a driver for the USB Cable Adapter (UCA)
before you can use it to communicate with your logger. You
can find the driver installer on your ECH2O System Software
CD or from Decagon's website at www.decagon.com/support/
downloads.

Configuring in ECH 2O Utility
Before field installation, the Em50 needs to have certain
parameters set, such as name, date and time, measurement
interval, and communication mode. Also, the radio-enabled
Em50R and the cellular Em50G will not respond to wireless
contact until properly configured to do so. To configure the
logger, do the following: 

1. Open the ECH2O Utility program.

2. Plug the 3.5 mm connector of the UBS cable (included
with your Em50) into the logger’s COM port, and plug the
USB into the serial port of your computer. 
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Port diagram

3. At the top of the screen, select the appropriate COM port
from the “Connect Via” drop-down menu, then click on the
“Connect” icon.  If you are using the USB Cable Adapter,
look for the "Connect Via" option that includes "Decagon
UCA" in the COM port name.

NOTE:  If you cannot connect to your Em50, you may need to
install the driver for the USB cable.  To download a driver go
to www.decagon.com/support/downloads. 

4. Once you have successfully connected, the menus on the
main screen will become active. 

5. At the device setup screen that appears, click on the various
fields to enter a name for your logger and choose sensor
types for each port.

When using the Em50R, select the radio settings you plan to
use (See Chapter 6). Click on “Apply” to save the changes.
When using the EM50G, select your communication config-
urations (see Chapter 4: Software and Configuration).

6. Press the “Disconnect” icon when finished.

serial
communication
port
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Field Installation 
NOTE:  To watch a five minute video on installation, visit
www.decagon.com/videos. 

The Em50 will serve as a collection station for up to 5 sensors.
The Em50 is compatible only with sensors made by Decagon
such as the ECH2O water content probes, rain gauge, temperature
sensors, etc. To install the Em50 and sensors, do the following:

1. If you are using the Em50R or Em50G, perform a telemetry
test to check the wireless signal.  If your signal is low or
does not exist, move to an alternative location. (Sometimes
only a few feet away will be sufficient.)

2. Install your sensors as directed in the respective sensor’s
manual.

3. Plug the sensor’s jack firmly into the Em50 input port. 

4. On the top and bottom of the Em50, there are two loop-
holes. Use these to fasten the Em50 to a mounting post
using the included zip-ties or a similar fastener. Make sure
it is installed in an upright position, with the 5 input ports
underneath. In this position, rain and spray are shed by the
enclosure and drip off without affecting the contents of the
Em50 enclosure.

5. Configure the Em50 using ECH2O Utility, ECH2O Utility
Mobile, or DataTrac 3.

Cautions
When you install an Em50 series logger, remember:

• Do not immerse the Em50 in liquids.
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• Make sure to install the Em50 upright to reduce the pos-
sibility of water entering the Em50 enclosure. 

• Do not install Em50R or Em50G wireless loggers near
large metallic objects, as these can attenuate the radio
signal. 

If the Em50R or Em50G is mounted to a metallic post, be sure
to use an antenna extension cable to mount the antenna to the
top of the post. This will maximize the transmit range of the
Em50 wireless transmission.
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4. Software & Configuration

The Em50 series data loggers were designed to have simple
configuration and no data logger programming.  The software
packages below were designed to fit a variety of users.

• ECH2O Utility --Use ECH2O Utility for basic data logger
configuration and direct connect data download in Excel
format.  For users with a windows laptop, netbook, or
desktop computers.  

*ECH2O Utility cannot download Em50G data from
Decagon Data Service.

• DataTrac 3--Use DataTrac 3 for configuring and orga-
nizing multiple Em50 series loggers.  DataTrac 3’s data-
base system automatically updates newly downloaded
data and creates graphs of complete data sets from each
logger.  DataTrac 3 is the premier software for download-
ing and collecting data from Em50R or Em50G sys-
tems.  This software is best if you are interested in
viewing your data on a daily or weekly basis because of
the software’s ability to automatically append new data
collected by each logger.

• ECH2O Utility Mobile --Use ECH2O Utility Mobile to
configure and download data on Em50 data loggers when
using a handheld device such as an Archer or iPAQ run-
ning Windows Mobile.

• Em50G Downloader--Use Em50G Downloader when
you do not have DataTrac 3 to download Em50G data
from the Decagon Data Service.  Downloaded files are
saved as Excel files..  
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DataTrac 3 and ECH2O Utility Mobile have their own desig-
nated manuals.  Instructions for ECH2O Utility and the Em50G
Downloader are included here.

ECH2O Utility

ECH2O Utility provides a user-friendly interface for configur-
ing and downloading data from the Em50 logger. After install-
ing the program (see Chapter 3: Setup and Installation for
instructions), launch the program. You will see the main
screen:

The ECH2O Utility Main Screen

Here you can set all logger configuration parameters with
visual controls. At the top of the program window is a toolbar
for interacting with the Em50. To the left is a battery indicator.
To the right is the “Connect Via” menu, where you can select a
COM port; the Connect button (which displays “Disconnect”
when you are connected to an Em50); the Download button,
which downloads data saved on the Em50 onto your computer;
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and the Scan button, which scans all of the sensors connected
to each port on the Em50, and returns a real-time reading.
These functions will be described in detail further in this chap-
ter. Below are the most common tasks that can be performed
with the ECH2O Utility, explained in detail.

Common Tasks in ECH2O Utility

Configuring the Em50/Em50R/Em50G
The Em50 doesn’t require any programming. It does have sev-
eral parameters that control identity and function. To change a
parameter, connect to your device, change the desired parame-
ter, then click “Apply” to send the parameter changes to your
device. Here is a brief description of each:

Name. Each Em50 device should have a unique name. The
default name is the unit’s serial number. You can change this to
any legal name you want. A legal device name uses upper and
lower case letters, numbers, underscores, and hyphens. Spaces
and most punctuation are not legal name characters. ECH2O
Utility prevents you from choosing a name containing illegal
characters.

Serial Number. When set in the factory, this is a read-only
value.

Measurement Interval. The Em50 and Em50R loggers allow
you to select a measurement interval between 1 and 1440 min-
utes while the Em50G allows you to set a measurement inter-
val between 5 and 1440 minutes. A measurement interval of
zero (0) or “off” stops the logger from making measurements.

Port Sensors. The Em50 requires you to identify the sensor
type for each of the five sensor ports.
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Cellular Settings.  To turn the cellular network of the Em50G
on or off, click the “Configure” button in the “Communication
Option” section.  The cellular network is active when “Upload
data to ECH2OData.com” box is checked and is off when the
box is not checked.  The Em50G is uploading data to the Deca-
gon Data Service (“on”) by default. See Chapter 5. Em50G
Cellular Communications for more information on the Em50G.

Choose up to six upload times.  Default upload times are: 6-7
AM, 10-11 AM, 1-2 PM, 4-5PM. To conserve battery power,
choose fewer upload times.  

Click “OK” after making configuration changes. Click
“Apply” to save communication settings in your Em50G.  Your
current settings will show up in the communications option
field.

ECH2O Utility helps you evaluate the quality of the cellular
connection on your Em50G with the Communication Test fea-
ture. Please see Chapter 5. Em50G Cellular Communication
for a step-by-step guide to running the Communication Test.

Radio Settings. Only devices that have a radio module will
support these options (Em50R, DataStation).  See Chapter 6:
Em50R Radio Telemetry for more information on using the
radio settings.

Downloading Data when Directly Connected
Once the Em50 is properly configured and installed, it will
begin making and storing sensor measurements. Stored data
can be downloaded from the logger starting at two places in the
logger’s memory. The “Download New” option downloads the
data stored since the last successful download. The “Download
All” option downloads all the data currently stored in the
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Em50. The “Download” button on the toolbar corresponds to
the “Download New” option. Any model of Em50 data logger
supports downloading data when directly connected to the log-
ger with ECH2O System software.
 
To download data, do the following:

1. Use the USB cable to connect the Em50 to your computer. 

2. Choose “Direct on” the appropriate COM port from the
“Connect Via” drop-down list and press the “Connect” but-
ton. If you encounter connection errors, please see Chapter
11: Troubleshooting or the ECH2O Utility Help File.

3. Once connected to an Em50, either click the “Download”
button on the toolbar, or go to the Data Menu and select a
download option as described above. 

4. When saving data, the File Save dialog suggests a name
based on the connected logger’s name and the time and
date. However, you can enter any name by typing it into the
“File name” field. 

5. Choose the file format you prefer then click “Save”.
ECH2O Utility will download the data and create the file. 

ECH2O Utility can save your data in several different file formats:

• Excel Workbook File (.xls): Converts the raw
down-loaded measurement data into engineering values
appropriate for each sensor type. The converted data are
saved to sheet 1 of the workbook. Raw data are saved to
sheet 2. You can use the raw measurement data to apply
custom calibration to your sensor data.

• DataTrac Data File (.dxd): Saves the file in a format
that DataTrac can import. Each dxd file contains infor-
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mation about the ECH2O logger's settings, identity, and
status along with the raw data for each sensor.

• Processed Data Text File (.txt): Converts the raw
down-loaded data into engineering values appropriate for
each sensor type. Data are saved as a tab delimited text
file.

• Raw Data (.csv): Saves the raw data in the form
down-loaded from the logger. 

NOTE:  The DataTrac file format (.dxd) is a useful way to store
data for later manipulation. Each .dxd file contains information
about the ECH2O logger’s settings, identity, and status along
with the raw data for each sensor. ECH2O Utility will process a
.dxd file into an Excel file or a processed text file. This allows
you to re-process your raw data with different settings or file
formats as needed.

Other Data Download Options
An Em50R supports downloading data wirelessly. ECH2O
Utility can establish a two-way radio connection between your
computer and a remote Em50R through the Rm1 Radio
Modem. Once this connection is established, downloading data
from the Em50R is handled just like a download when directly
connected to the logger. See Chapter 6. Em50R Radio Teleme-
try for more information on setting up two-way wireless com-
munications. 

The Em50R also supports wireless sensor networks. In this
mode, the Em50R transmits measurement data to a DataSta-
tion. You can then download the measurement data from all the
Em50Rs in your network from one location. See Chapter 6.
Em50R Radio Telemetry for more information on setting up
logger networks.
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The Em50G logger is designed to upload your measurement
data to Decagon Data Service using the cellular network. This
makes it easy for you to use the internet to download your mea-
surement data from anywhere in the world. Please see Chapter
5: Em50G Cellular Communications for more information.

NOTE:  ECH2O Utility uses the default conversion equation for
each sensor when converting raw data to processed data. For
more information about the default conversion equations, please
see your logger or sensor manual.

Erasing Data
If you need to erase the data on your Em50, go to Data > Erase
Stored Data. You should erase your data if you change the
Em50’s configuration settings, such as what type of sensor is in
each port. After selecting the Erase option, you will be asked if
you want to continue. Click Cancel to return to the program, or
Erase Data to continue. 

WARNING! Once this feature is activated, ALL stored
data will be erased and cannot be recovered! 

Instantaneous Measurements (Scan)
The ECH2O Utility gives you the ability to take real-time sen-
sor measurements with your Em50 logger. This is most useful
as a troubleshooting feature to test if a sensor is reading prop-
erly. You can also see how sensors react to environmental
changes.  To take this type of reading:

1. Click the “Scan” button in the toolbar, or go to Actions >
Scan Logger Ports. The Em50 will take a reading on each
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of the ports, then display a screen similar to the one below.

2. All 5 ports are displayed, along with the measurement for
each port in the units appropriate for the sensor. You can
change measurement units in the Preferences Menu (see
“Measurement Units” in Chapter 5). Click the sensor’s
name to see the reading as raw data.

The five ports are displayed, along with the measurement for
each port in the current selected unit. If nothing is plugged in to
a port, the reading for that port will be zero.  

NOTE: Data measured with the scan function will not be
stored in the Em50.

ECH2O Utility Menus

The ECH2O Utility features six menus that allow you to access
the program’s features. This chapter discusses the features of
each menu.
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The File Menu

Save Settings File.  Selecting the “Save Settings File” option
from the File menu will create a data file that contains all of the
settings and information associated with the connected Em50.
This feature is useful for transferring logger configurations
between ECH2O Utility and ECH2O DataTrac. By default, the
name of the settings file is the name of the selected Em50.
After naming the file and selecting where it will be saved, click
Save to create the file. 

Convert Data File.  ECH2O Utility will “process” or convert
raw ECH2O sensor data to processed data. This feature works
by reading a file containing raw data and outputting the pro-
cessed data into a different file. You can convert DataTrac data
files (*.dxd) and EchoLink download files (*.csv or *.txt).
Only files saved with ECH2O Utility and ECH2O Utility
Mobile can be converted to processed files. You can choose to
save your processed files as an Excel file or text file.

Edit Menu

The Preferences Menu.  The main feature of the Edit Menu is
the Preferences menu. The Preferences menu features four tabs
for navigation: Measurements, Data Files, Communications,
and Application. Below are a list of the most common tasks
that can be performed in each tab.



Em50/Em50R/Em50G Operator’s Manual
4. Software & Configuration

28

1. Measurements Tab 

Measurement Units. These are the unit values that will be dis-
played when downloaded data are saved as Excel, processed, or
raw data files. ECH2O Utility supports displaying some mea-
surement data in multiple units. For example, it allows you to
choose degree Celsius or degree Fahrenheit for temperature sen-
sors. To set your preferences for measurement units, choose the
“Measurements” tab in the ECH2O Utility Preferences window. 

Locate the type of measurement and select a unit from the
drop-down menu next to it. Click “Close” to apply the changes.

Power Noise Filter. The AC electrical power in your office or
home can add a subtle amount of noise to the data logger sensor
measurements. The logger’s Power Noise Filter setting is
designed to eliminate this electrical noise that comes from the
AC power distribution system. You should set the value of the
Power Noise Filter to match the frequency of the power cycle
where you live. In North America and most of Asia, this is 60 Hz
(the default value). In most of Europe the electrical frequency is



      Em50/Em50R/Em50G Operator’s Manual
4. Software & Configuration

29

50 Hz. This feature only needs to be set once, as the program will
automatically update the filter of each device that it connects to. 

2. Data Files Tab

Column Headers. The column header gives each column a title
corresponding to the port number, measurement type, and unit.
Column headers for saved data files are turned on by default,
and apply only to processed and raw MS Excel data, as well as
processed text data. De-select “Include column headers” to
turn off the column headers for these file types.

Setting Date/Time Format for Data Files. You can control how
the date and time values are formatted in the data file. By
default, the time and date are formatted using the settings in the
Windows Regional & Language Options control panel. You
can modify this to display the date and time in dd/mm/yyyy
format with either a 12- or 24-hour clock. To change the for-
mat, select an option from the menu, then click “Close” to
apply the changes. 
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3. Communications Tab
The Communications preference tab has items that control how
the serial communication works between ECH2O Utility and
your Em50. Generally you should not adjust these settings
unless you are experiencing problems communicating with
your Em50.

Direct Command Retries. ECH2O Utility automatically retries
commands it sends to your Em50 when there are errors. For
most circumstances, the default retries work well. If you expe-
rience unreliable communication with your Em50, you can try
increasing the Direct Connect Retries.

Maximum Baud Rate. Set a baud rate lower than the default
115,200 baud if you consistently experience serial connection
problems. 

Communications Port List. ECH2O Utility is compatible with
most USB-to-Serial adapters. Some models of USB-to-Serial
adapters are not found by the serial port enumeration feature of
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ECH2O Utility. If your model of USB-to-serial adapter is not
recognized, enable “Force find all Communication Ports” in
the Preferences Menu by going to the Communication tab, and
enabling the check box at the bottom of the screen. Enabling
this option may find other serial ports that are not available for
use by the ECH2O Utility (for example, modems installed in
your computer). 

4. Application Tab

Automatic Internet Version Check. ECH2O Utility will auto-
matically check for a newer version using Decagons internet
version-check engine. When this option is selected, it will
notify you when a newer version is available if you are running
ECH2O Utility, and if your computer is connected to the inter-
net. You can turn off the automatic check by un-checking this
option. You can manually check for updates any time using the
“Check for ECH2O Utility Updates” option in the Help menu. 

Automatic Clock Synchronization. By default, the ECH2O Util-
ity automatically synchronizes your logger’s date and time to
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the time set on your computer. You can disable this feature by
un-checking this option. You can also update the date and time
in your logger any time it is connected by selecting Actions >
Set Date/Time. 

Error Log File. The ECH2O Utility keeps a log file of errors
and events. Adding more messages to this file is useful for
troubleshooting. Check this option to add more error and event
messages to the error log. 

Date and Time Display in the ECH2O Utility. You can control
how the date and time for your Em50 is displayed in the toolbar
status area. By default, the time and date are formatted using
the settings in the Windows Regional & Language Options
control panel. You can modify this to display the date and time
in dd/mm/yyyy format with either a 12- or 24-hour clock.

Data Menu
The Data menu has three options: Download New Data,
Download All, and Erase Stored Data. For more information
on these functions, please refer to their respective sections in
Chapter 4.

Actions Menu
Connect/Disconnect.
Performs the same function as the connect/disconnect button in
the toolbar. It initiates a data communication connection
between your Em50 and your computer. You must first connect
to your Em50 before downloading data.

Get Settings
This command retrieves all the port and configuration settings
from your Em50. These settings are automatically collected
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when you connect to your Em50. You can use this option to
check to make sure your changes are stored in the Em50.

Apply Settings
Applies the parameters you changed to your Em50. This oper-
ates just like the Apply button on the main screen. This option
is only available when there are parameter changes available to
send to the Em50. 

Scan Logger Ports
This option allows you to take readings from each port inde-
pendent of the others. See the section “Instantaneous Measure-
ments” in Chapter 4 for details and procedures.

Digital Sensor Terminal 
The Digital Sensor Terminal is used for SDI-12 addressing and
query of our digital SDI-12 sensors.  See these sensors’ respec-
tive manuals for additional information on SDI-12 capabilities.

Set the Date/Time
When you select this action, the ECH2O Utility will set the
Em50’s time and date to be the same as the time and date on
your computer.

Communication Test 
When the Em50R or Em50G is connected using ECH2O Util-
ity, use “Communication Test” to see how well your logger’s
wireless communication is working.  If the test suggests that
you have a poor connection, you can move to a new location
and re-try the communication tests.  
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Device Tools
The Device Tools submenu contains the following items:

Test Device Firmware. This option is useful in determining if
you have any firmware (the internal software that runs the
Em50) errors. To initiate a firmware test, select Actions >
Device Tools > Test Device Firmware. This will automatically
test the integrity of your Em50’s firmware, and report if it
reads as Bad or Good.

Initialize Radio Module. Resets the radio module to the
default setting. This option applies to Em50Rs and DataSta-
tions only. 

Initialize Device. Initializing your Em50 is a form of a hard
reset. ECH2O Utility resets your Em50 and re-writes all the
logger settings. All your measurement data is erased. This
option is useful for troubleshooting a logger that is not working
as expected. 

NOTE:  Initializing your Em50 will delete all stored data.
Make sure any data has been downloaded out of the Em50
before initiating a reset.
 
Window
The Window Menu contains the Show Terminal command.
The terminal window allows you to directly enter commands
for your Em50, and is mainly used for troubleshooting and
diagnosis.  

Help
The Help Menu allows access to the ECH2O Utility help file,
allows you to check for program and firmware updates, and
displays information about your copy of the ECH2O Utility.
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ECH2O Utility Help
This menu item opens the help file. It contains some of the
information found in this manual. 

Send Feedback to Decagon
This menu item helps you send product feedback, bug reports,
or feature requests to Decagon. Your computer must be con-
nected to the internet for this feature to work. See Appendix B
for more information.

Check for Utility Updates
This function checks for the newest available version of the
ECH2O Utility. Make sure you are connected to the internet,
then select Help > Check for ECH2O Utility Updates. The pro-
gram will check to see if there is a newer version available. If
there is, it will direct you to the web page where you can down-
load it. To check for a newer version of the ECH2O Utility,
choose this menu item. Checking for updates for the ECH2O
Utility uses Decagon's version-check web engine. Your com-
puter must be connected to the internet for this feature to work.

Check for Device Firmware Updates
This menu item is only available when you are connected to an
Em50 (or other ECH2O device). It compares the firmware ver-
sion of your Em50 with the latest version available from Deca-
gon. You can download a firmware updater when a new
version is available. Your computer must be connected to the
internet for this feature to work.
 
About the ECH2O Utility
This menu item opens the “About” window. You can see the
version of your copy of ECH2O Utility here.
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Em50G Downloader
The Em50G Downloader is used to securely connect to Deca-
gon’s internet server to download Em50G data in Excel format.  

Em50G Configurations in Em50G Downloader
After installing the Em50G Downloader, you will first be
prompted with User Configurations.  Your e-mail and pass-
word are used by Decagon to link you to your Em50G data log-
ger(s).  The additional information requested will help with
support issues, but is not required.  After you complete the user
configurations, you are ready to add new Em50G loggers to
your subscription.

Add a Subscription
In order to view data from an Em50G, you must first “sub-
scribe” to that Em50G. You are not limited by the number of
Em50G loggers that you can subscribe to.  To subscribe to an
Em50G logger: 

1. Select  “Add Subscription”.

2. Enter the “Device ID” and “Password” that are on the Em50G
information card that came with your Em50G logger.  The
Device ID and the Password are unique to each Em50G.  

3. Pick the server from which you will retrieve your data.
The “ECH2O Production Server” is the default server and
should be used unless specified by Decagon.  

4. If you are downloading data from an Em50G that has been
logging data prior to the subscription addition,  set the
“Retrieve” date for the date that you want to start receiving
data from.  
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All of the Em50G loggers that you have subscribed to will
show up in your Em50G downloader page.  When you press
“Download”, data is downloaded from the server for all log-
gers that are enabled (checked).  Em50G data is saved as both
Excel and DXD files in C:\Documents and Settings/<localuser-
name>\My documents\ ECHO2 Data Trac\Auto Import\ .
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5. Em50G Cellular Communication

The Em50G data logger is equipped with a GSM/GPRS cellu-
lar module that enables the logger to upload sensor measure-
ment data to Decagon Data Service. Your measurement data is
available for download directly to your Windows computer at
any time, anywhere in the world where you have internet
access. To extend your service plan contact Decagon at
sales@decagon.com or 1-800-755-2751.

Decagon Data Service
The Em50G uses “push” technology to upload measurement
and logger status data to the Decagon Data Service on regular
intervals each day. This type of “push” technology allows the
Em50G to keep its cellular hardware powered off for most of
the time allowing long battery life. The logger uses a unique
cryptographic signature and checksum to protect the integrity
of the your data as it is transferred over the cellular network
and internet as it's uploaded to the Decagon Data Service.

The Em50G keeps track of the data successfully uploaded to
the Decagon Data Service. If your logger is unable transfer
data during one regularly scheduled session, the data is
included in the next upload session.

Once stored in the Decagon Data Service, your measurement
data is available for download over the internet. Downloading
data does not remove it from the Data Service. It is safely
stored for download at any time. 
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Cellular Service 
Decagon makes using the cellular network easy by including
the first year of service with the Em50G. Decagon partners
with over 200 GSM/GPRS network operators in 120 countries
to provide cellular service all over the globe. Decagon has pre-
configured your Em50G with an appropriate SIM card for the
location where you plan to use your logger. The SIM card and
associated service Decagon provides is only for use with the
Em50G as outlined by the usage agreement in Appendix C.

NOTE:  Please check with Decagon before moving an Em50G
from one country to another to make sure your service plan is
appropriate for the new location.

To extend your service plan or to troubleshoot your cellular
service, please contact Decagon or the authorized Decagon
Distributor where you purchased your Em50G. 

Cellular Coverage
The Em50G requires GSM/GPRS cellular service to upload
measurement data to Decagon Data Service. In the USA, the
Em50G operates on the T-Mobile and AT&T networks (the
Em50G is not compatible with the Verizon or Sprint networks).
Outside of the USA, the Em50G should be compatible with
technology used by most cellular carriers.

ECH2O Utility offers a “Communication Test” feature that
allows you to evaluate the quality of the cellular network cov-
erage where you plan to install the Em50G. This allows you to
evaluate the cellular coverage before installing your logger.
Repositioning your logger a short distance may improve your
cellular coverage.
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For measurement site planning, it may also be useful to consult
the network coverage tools offered by each carrier. Please con-
tact Decagon for specific questions about the cellular coverage
offered by our partner networks.

In some cases, it may be necessary to use a directional antenna
to boost the cellular signal strength of the Em50G to maintain
regular data uploads. Please contact Decagon for additional
support.

Em50G Configuration and Settings
The Em50G is configured to upload data to Decagon Data Ser-
vice right out of the box. To start logging and uploading data,
configure your logger with the type of sensors installed in each
port and turn on sensor logging by choosing a measurement
interval. The Em50G will begin uploading data according to
the default schedule (uploading between 6-7 AM, 10-11 AM,
1-2 PM, 4-5PM each day).
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Use ECH2O Utility to change these default settings. To turn the
cellular network of the Em50G on or off or change the upload
times, click the “Configure” button in the “Communication
Option” section.  The cellular network is active when “Upload
data to ECH2OData.com” box is checked and is off when the
box is not checked. In this dialog box, you can choose up to six
upload times that correspond to the times when you want to the
most up-to-date sensor data available for downloading. The
Em50G uses a random time within the hour to reduce resource
loads on the cellular network and Data Service. To conserve
battery power, choose fewer upload times.  

NOTE:   Please contact Decagon if your application requires
measuring sensors more often than every 5 minutes or if you
need data uploads more often than 6 times a day.

Click “OK” after making configuration changes. Click
“Apply” to save communication settings in your Em50G.  Your
current settings will show up in the communications option
field.

NOTE:  Sensor data recorded by the Em50G while it is config-
ured not to upload data to the Data Service will be stored in the
logger, but will not be uploaded to the Data Service. Turning
on the upload feature will start uploading data collected on the
next measurement interval.

Communication Testing
ECH2O Utility helps you check the quality of the cellular com-
munication of your Em50G using the Communication Test fea-
ture. Open the Em50G Communication Test dialog by clicking
the “Test” button or choosing “Communications Test…” in the
Actions menu. 
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The test takes approximately 30-60 seconds while the Em50G
establishes a connection with the cellular network and sends
test packets to the Decagon Data Service. Once the tests are
finished, the “Connection Quality” field reports connection
quality based on cellular signal strength and successful packet
transfers. After the initial test is finished, clicking the “Test”
button again will update the cellular signal strength and re-send
test packets. Subsequent tests are much quicker than the initial
test because the Em50G is already connected to the cellular
network and the Decagon Data Service. Re-testing your con-
nection quality allows you to find the best spot to install your
Em50G. If one test fails, be sure to try the test again.

NOTE:  The cellular radio is on while the “Em50G Cellular
Test” dialog window is open. Be sure to close the window when
you are done testing to preserve battery power.

If the connection quality of your Em50G is poor, sometimes
moving your logger a short distance will improve the signal
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strength. Also consider elevating the antenna by elevating the
logger or using an antenna extension cable to improve signal
strength. In some cases it may be necessary to use directional
antennas to have sufficient cellular signal. Please contact Deca-
gon or your Decagon representative for help choosing the cor-
rect antenna for cellular frequencies used at your location.

The Communication Test is checking both the cellular signal
strength and the connection to the Decagon Data Service. If the
Data Service is temporarily unavailable due internet problems,
the connection quality will report a failure even if you have
strong cellular signal. If your cellular signal strength is good
(above ‘12’) then it is reasonable to expect good connection
quality once the Em50G can re-connect to the Decagon Data
Service.

NOTE:  The measurement data collected by your Em50G is
automatically queued for the next successful connection to the
Decagon Data Service. The integrity and continuity of your
data is not affected by short term cellular or internet outages.

Downloading Data
You have two options for downloading the sensor measure-
ment data collected by your Em50G.

Direct Download
Like all Em50 loggers, the Em50G stores more than 36,800
sensor readings for each of the 5 sensor ports. You can use any
ECH2O system software to directly connect to the logger for
data download. Your data are always safely stored in non-vola-
tile memory as a backup in unlikely event of data loss on your
computer. For downloading instructions when directly con-
nected, see “Downloading Data” in Chapter 4.
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Internet Downloading
The Em50G and Decagon Data Service make downloading
your measurement data over the internet convenient and easy.
Use DataTrac 3 to subscribe to data collected by your Em50G.
The Em50G Downloader application is also designed to down-
load Em50G data.

NOTE:  ECH2O Utility does not connect to the Decagon Data
Service for downloading data over the internet. You must use
either DataTrac 3 or the Em50G Downloader.

Install either DataTrac 3 or the Em50G Downloader (not both)
from the install CD that came with your logger. You can also
download the latest version from www.decagon.com/support/
downloads/.

When you first launch either the DataTrac 3 or the Em50G
Downloader application, you are prompted to enter your user
contact information as shown on the screen below. 
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Decagon uses this information to link you to your subscribed
Em50G to provide customer support in the event your logger
isn't working as expected. You can update this information at
any time by choosing “User Configuration” from the Settings
menu. Once you've completed the user information, you are
ready to add new subscription information.

In order to download data over the internet for a specific log-
ger, you must first “subscribe” to that Em50G logger. You may
subscribe to any number of Em50G loggers. Remember that
during the subscription process you must be connected to the
internet.  To subscribe:

1. If you are using DataTrac 3, click “set-up”, “new” and then
“Em50 subscription”.  If you are using the Em50G down-
loader, click the “Add” button.  The following screen will
appear.

2. Enter the unique “Device ID” and “Password” for your
Em50G. You will find this information on the brightly col-
ored card that came with your Em50G logger. Keep this
card in a safe place.

3. Make sure the “Server” option is set to “ECH2OData.com
(Default)”.
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4. Pick the amount of data you want to include in the first
download. If this is the first time you are downloading data
from this logger, you should choose the “All Data Points”
option. If you are only interested in downloading data
uploaded over the last day or last week, choose “Last Day”
or “Last Week” respectively.

5. Click “OK”. The Em50G Downloader will communicate
with the Decagon Data Service to verify the information
you’ve entered.

Repeat the above steps for each of your Em50G loggers. You
can add new logger subscriptions at any time. 

Click the “Download” button to download any new measurement
data sent by your Em50G loggers since the last time you down-
loaded. Data files successfully downloaded for each logger is
saved in DataTrac 3’s auto-import directory (My Documents\
ECH2O DataTrac\AutoImport\). When DataTrac 3 launches, it
will automatically process the files in this directory by appending
this data to the appropriate logger. 

NOTE:  DataTrac 3 will list loggers in the “New Devices” sec-
tion by the logger name when it encounters a logger it hasn't
seen before. Select your Em50G by its name, and choose the
“Configure” button on the DataTrac toolbar. Set the location
information if desired, then press “OK”.

The Em50G Downloader application is configured by default
to automatically start a download when launched. This is
designed to reduce the number of actions necessary to retrieve
and view data collected by your Em50G logger. You can adjust
this setting by choosing “Preferences” from the Settings menu
of the DataTrac 3 or  Em50G Downloader application.
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The Em50G Downloader application main window shows the
user-set name, download server, and battery status for each
Em50G logger. It also shows the last time you downloaded
data from the Decagon Data Service with the number of mea-
surement “Scans” included in the download. If the value for
“Scans” is zero, it means the logger hasn’t uploaded any new
data since the last time you downloaded data. Please try your
download again later. If you are unable to download new data
when expected, please contact Decagon or your Decagon rep-
resentative for support. If there are specific times during the
day you want to download the latest data, please make sure
your Em50G is configured to upload data during the previous
hour.

Managing Subscriptions 
The DataTrac 3 and Em50G Downloader application attempts
to download data from each logger in the main window. If you
want to stop subscribing from a logger permanently, select the
logger in the list and choose “Delete Subscription” from the
File menu.
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Sharing Data
The Em50G and Decagon Data Service also make it easy to
share your measurement data with a colleague or collaborator.
You control who has access to specific Em50G data by provid-
ing the unique Device ID and Password pair associated with
each logger (found on the brightly colored card shipped with
each Em50G).

NOTE:  You should keep the Em50G Device ID and Password
card in a safe place. Don't leave it inside the Em50G logger case.
Only share the information on the card with people you wish to
have access to the data published by your Em50G logger.

There is no limit to the number of people who can subscribe to
each Em50G. Each subscriber runs their own copy of the
Em50G Downloader application or DataTrac 3. The tools make
sure each subscriber downloads new data since their last down-
load. One subscriber’s downloads does not interfere with
another subscriber’s downloads.
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6. Em50R Radio Telemetry

This chapter gives you a brief overview of the radio telemetry
available in the ECH2O system. This information only applies
to Em50R. The ECH2O system supports two types of radio
telemetry: “Two-way” modes and “Transmit” modes. Consider
one or both types of radio modes when designing your ECH2O
telemetry system. The “Confirm Delivery Transmit” mode
ensure the most complete data transfer and the best battery life.
However, there are some unique cases where you may want to
use the other available modes.

NOTE:  To utilize the radio communication capabilities of the
Em50R, you will also need either a DataStation  or an Rm-1.

ECH2O telemetry networks require each remote radio logger to
have a unique name. Each logger leaves the factory with the
name set to the logger’s unique serial number. You can easily
change the name of the logger to help you identify or organize
your data. You should not give two loggers the same name.
Two loggers with the same name will interfere with each other
when communicating over the radio.

Transmit Radio Telemetry
The Transmit Radio modes help you create a simple network of
remote radio loggers all transmitting data to a DataStation
radio base station. The DataStation stores data from all the
remote loggers in one convenient place. Typically, a DataSta-
tion is connected to your computer where you can easily down-
load the data for use in DataTrac 3. Unlike the Two-way Radio
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modes, you can’t remotely change logger settings when using
this mode.

When a logger is in Transmit mode, it only turns on the radio
when it has new data to broadcast. For example, when you set
the measurement interval in your logger to 60 minutes, the log-
ger stores your data every hour and then broadcasts the data to
a listening DataStation. The actual transmit time is randomly
delayed for several minutes to prevent two or more radio log-
gers from interfering with each other. 

The Transmit radio modes use less battery power because the
radio is off most of the time. The Em50R is designed to work
approximately 12 months in Transmit mode.

NOTE:  A DataStation is a receiver. It doesn’t cause the remote
logger to send data. If your DataStation is powered off for
some time, it won’t receive data sent by the remote loggers.
However, the missing data is still stored in the logger.  You can
directly connect to the logger to download the missing data.

Transmit Radio Modes
Use the Radio Tab in the logger settings form to choose one of
the following radio modes that support Transmit communication.

Confirmed Delivery Transmit:  This is the recommended
mode since it is the most robust Transmit radio mode. The
radio logger adds a checksum to the data packet before broad-
casting the data to a DataStation. The logger then waits for the
DataStation to confirm it correctly received the data packet. If
the logger doesn’t hear the confirmation, it retries sending the
packet again. The logger stops trying to transmit to a DataSta-
tion after 25 attempts.
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Transmit Only:  This is the original Transmit radio mode. It
doesn’t offer the advantages of the Confirmed Delivery Trans-
mit mode. You should use the Confirmed Delivery mode when
possible. Em5R (discontinued) loggers only support this Trans-
mit radio mode.

Transmit + Two-way and CD Transmit + Two-way: These
modes combine the Two-way Radio mode and the Transmit
Radio mode. You could use these modes while configuring and
testing your radio network. You should not leave your radio log-
ger in these modes because they use the most battery power of
all the radio modes. Using Transmit + Two-way and CD Trans-
mit + Two-way radio modes with the wake interval set to 1 or 2
will cause the batteries of your logger to drain very rapidly.

Transmit Best Practices
Transmit modes are most useful when you have three or more
loggers installed within radio range of each other. There is no
set limit to the number of radio loggers broadcasting to a Dat-
aStation. Use this mode for as few as one logger and as many
as 50 or more loggers. You should use the Telemetry Test fea-
ture of ECH2O Utility to test the connection from your logger
to the DataStation.

NOTE:  Em50R loggers must have firmware version 1.12 or
later to enable the Confirmed Delivery Transmit mode and
Telemetry Test feature. Your DataStation must have firmware
version 1.09 or later to receive Confirmed Delivery Transmit
mode data packets. Contact Decagon for an application note
that covers the steps needed to upgrade your hardware.



Em50/Em50R/Em50G Operator’s Manual
6. Em50R Radio Telemetry

52

See section on DataStation Networks for step by step instruc-
tions for configuring your DataStation and remote radio loggers.

Two-way Radio Telemetry
The Two-way Telemetry Mode lets you establish a two-way
connection with a remote radio logger. Once connected to the
remote logger, you can download data and change most set-
tings just like you were connected directly to the logger with a
serial cable. Communicating with a remote radio logger
requires you to have a Rm1 radio modem connected to your
computer. Connecting to the remote radio logger happens
through the Rm1.

When a logger is in a Two-way Radio Mode, it turns on its
radio every 45 seconds. While the radio is on, the logger listens
for connection attempts from a Rm1. If the logger doesn’t hear
any connection attempts, it turns off the radio. If the logger
hears a connection attempt, it leaves the radio on for several
seconds listening for login commands from ECH2O Utility. It
takes up to 60 seconds to connect to the remote logger.

When you are finished interacting with the remote radio log-
ger, you press the disconnect button. ECH2O Utility sends a
“logout” command to the remote logger to indicate the end of
the communication session. When the remote logger hears the
“logout” command, it waits for 10 minutes before listening for
additional connection attempts via the radio (you can always
direct connect to your logger). This allows you to connect to
other loggers with the same radio settings. Otherwise, the first
logger you contacted may reconnect. This would prevent you
from connecting  to your other loggers.
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The Two-way modes generally consume the most power. The
Em50R is designed to work for several months in the Two-way
modes.

Two-way Radio Modes
Use the Radio settings section of ECH2O Utility to choose one
of the following radio modes that support two-way communi-
cation.

Two-way 24-hour: The radio logger listens for connection
attempts every 45 seconds, 24 hours a day.  This mode uses a
substantial amount of batter power.  Expect batteries to last for
approximately 3 months.

Two-way 6:00-18:00: The radio logger listens for connection
attempts every 45 seconds between 6 AM  and 6 PM. The logger
doesn’t use the radio between 6 PM and 6 AM to conserve bat-
tery power, by not listening for connection attempts during the
night.  Expect batteries to last for approximately 6 months in
this mode.

Transmit + Two-way and CD Transmit + Two-way: These
modes combine the Two-way Radio modes and the Transmit
Radio modes. You could use these modes while configuring
and testing your radio network. You should not leave your
radio logger in these modes because they use the most battery
power of all the radio modes.  Expect batteries to last for
approximately 3 months in this mode.

NOTE:  Using Transmit + Two-way and CD Transmit + Two-
way radio modes with the wake interval set to 1 or 2 will cause
the batteries of your logger to drain very rapidly.
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Two-way Best Practices
Two-way modes are most useful when you have a small num-
ber (one, two, or three) of remote radio loggers you wish to
contact. If you have three or more loggers installed within
radio range of each other, consider using one of the Transmit
modes. The Two-way modes also allow you to mount an Rm1
in your vehicle and interact with the remote logger while in
radio range.

See section on Connecting via a Radio Modem for step by step
instructions for establishing a two-way connection with a
remote radio logger.

Radio Settings
For two radio devices to communicate they must share the
same radio settings. An Rm1 radio modem can only connect to
a remote radio logger with the same radio settings. A DataSta-
tion will only receive data from loggers with the same radio
settings as the DataStation. Set the Radio Channel to the same
value for all the devices on the same network. Set the Radio
Sub Channel to the same value for all the devices on the same
network.

Radio logger networks with different values set for the Radio
Channel use different frequency-hopping sequences, and there-
fore experience minimal interference between groups. Radio
logger networks with the same Radio Channel value but differ-
ent Radio Sub Channel values can interfere with each other,
but can’t communicate with each other. This interference can
also cause additional battery drain in the radio logger.
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The default values for Radio Channel and Sub Channel are
zero. Use  ECH2O Utility to choose other values.

Radio Performance
The maximum range of the radio modules in the radio logger
and DataStation are affected by the environment, installation
method, and antenna choice. Maximizing the range of your
radio network requires you to consider all of these factors.

Buildings, hills, vegetation, vehicles and other environmental
obstructions will shorten the radio’s range – sometimes drasti-
cally. You should ensure a clear, open path between radio
devices. Also, radio frequency (RF) interference in the envi-
ronment around the radio can reduce the usable range (even if
not using the same radio frequencies). You should consider
nearby growing vegetation when designing and testing your
radio network. Some radio networks work fine when the vege-
tation is sparse, yet may fail when vegetation is full.

You can increase the effective transmit range by maximizing
the height above ground of the radio antenna. This helps ensure
a clear path for the radio signals and reduces the amount of sig-
nal absorbed by the earth. Use an antenna extension cable to
help you position your antenna when it isn’t practical to install
your logger higher off the ground. If you mount your radio log-
ger to a metal pole, you should mount your antenna to the top
of the metal pole so it is free to radiate the signal above the
pole.

Replacing the stock antenna on your radio device with a high-
gain antenna can greatly increase the radio range. Consider
using a directional Yagi antenna or a high-gain omni-direc-
tional antenna when you want to extend the range of your radio
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network. A high-gain antenna can also help overcome the
effects of unavoidable environmental obstructions.

The ECH2O telemetry system also supports a simple relay for
use with Transmit Mode networks. Combining a relay and
high-gain antennas allows radio devices to communicate over
very long distances. Contact Decagon for more information on
using a relay in your radio network.

Connecting via Rm-1 Radio Modem 
Connecting to an Em50R via a Rm1 is different than  connect-
ing via your USB cable. Keep notes concerning the Em50R
name and radio settings to make the rest of the system configu-
ration easier to accomplish. 

Before you can use the telemetry options of your Em50R, you
must configure the Em50R by connecting it directly to your
computer using your USB cable.  Connect using ECH2O Util-
ity or DataTrac 3 and set the Em50R’s Channel, Sub Channel,
and Radio Mode. See the section on Configuring in ECH2O
Utility for additional information on configuring the Em50
series loggers.   The Channel can be set from 0 to 6 inclusive
(default is 0). The Sub Channel can be set from 0 to 65534
inclusive (default is 0). To use the radio logger with an Rm1,
the Radio Mode has to be set to one of the Two-way modes.

If the Two-way 6:00-18:00 mode is chosen, then connection
via the Rm1 can only take place between the hours of 6:00 AM
through 6:00 PM. This mode was designed to improve battery
life by not keeping the radio on constantly. The other Two-way
modes can be connected to 24 hours a day. 
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After setting the Radio Mode, click the “Apply” button in
ECH2O Utility. Disconnect from the Em50R logger. Now, con-
nect your computer to the Rm1 by using a standard 9-pin serial
cable. (A USB version of the Rm1 is also available.)

Choose the correct communication port in the “Connect Via”
drop-down menu. For example, if your Rm1 is physically con-
nected to your computers COM1 communication port, you
would choose “Rm1 on COM1 Communication Port” in the
“Connect Via” menu. Click the “Connect” button.

The Logger Query Configuration form will appear. To connect
to a specific Em50R, type the logger’s Name, Channel, and
Sub Channel. After typing the name, click the Query button. If
you want to connect to any available Em50R, pick the correct
Channel and Sub Channel, but leave the Name field blank.

NOTE:  To connect to a radio logger, the radio Channel setting
must be the same for both the logger and the Rm1. The radio
Sub Channel setting must also be the same for both the logger
and the Rm1.
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The Connection Progress screen appears as ECH2O Utility
tries to establish a radio connection with the remote logger
through the Rm1. The connection   process can take up to 60
seconds while ECH2O Utility sends a logger “wake up” signal
and retries the connection attempt.

When ECH2O Utility  connects to a remote radio logger, it
shows the signal strength of the connection with the radio sig-
nal strength icon on the status bar. Click on the radio signal
strength icon to see the signal strength percent in the message
area.

See Chapter 9: Troubleshooting if ECH2O Utility  fails to con-
nect to your remote logger.

Once ECH2O Utility establishes a two-way radio connection
with a remote logger, you can interact with the logger just like
a direct connection.

NOTE:  You cannot change the radio Channel or radio Sub
Channel settings in the remote logger while connected via the
Rm1.

DataStation Networks
Configure a DataStation 
After establishing a connection set the Channel and Sub Chan-
nel. Channel can be set from 0 to 6 inclusive (default is 0). The
Sub Channel can be set from 0 to 65534 inclusive (default is 0). 

Note the Channel and Sub Channel settings chosen. Click the
“Apply” button to save the settings to the DataStation. For easy
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data downloading and telemetry testing, leave the DataStation
plugged into your computer and your powered at all times.  

Configure an Em50R Logger for use with the DataStation
To use one or more Em50R loggers with a DataStation the
Radio Mode has to be set to one of the Transmit modes.  We
recommend the “Confirm Delivery” transmit mode.

Connect the Em50R to your computer or handheld device
using the appropriate cable.  Start ECH2O Utility, ECH2O Util-
ity Mobile or DataTrac. Once you’re connected, set the radio
Channel and Sub Channel settings to exactly the values chosen
for the DataStation previously. Set the Radio Mode to Con-
firmed Delivery Transmit. This mode provides a method for
confirming the delivery of the data which greatly increases the
ability of the system to successfully transfer the data. The
Transmit + Two-way modes are there for use as troubleshoot-
ing aids.  Set the measurement interval and pick the sensors
that will be plugged into each port.  See the section on Config-
uring in ECH2O Utility for additional details on configuring
the Em50 series.  After setting the Radio Mode, click the
“Apply” button.

NOTE: ECH2O Utility only shows the radio modes compatible
with your radio logger model and firmware version. If you
don’t see the “Confirmed Delivery Transmit” radio mode
option, then your radio logger may not support this option. If
you are using an Em50R logger you will need to update the
firmware to version 1.12 or newer. Visit www.decagon.com/
support/downloads for the most current firmware and software
modes.
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Communication Test 
Before finding a permanent location for your Em50R, perform
a communication test to verify the quality of the radio commu-
nication.  However, make sure your DataStation is properly
configured and powered during your communication test.  

In your field area, connect your Em50R to either a laptop or
handheld device using the appropriate cable and press connect.
Ensure that your radio channel and subchannel as well as your
transmit mode are the same as your DataStation. Choose
“Communication Test” from the Actions Menu.

Click the Test button and the test will begin. When the test has
finished you will be presented with the results of the test.  Five
stars signifies excellent communication. One star means that
all of your data are being transmitted, but multiple tries are
necessary.  The more attempts to send data means more power
is used.  Therefore, one star is adequate for data transmission,
but will decrease battery life.  
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You may have to relocate the radio logger while doing the
Telemetry Test in order to find the best connection quality.
Once you have found the radio logger location that provides the
best connection quality, install the radio logger at that location.

NOTE:  Communication Test only works with Em50 loggers
running firmware 1.12 or newer.

Download Collected Data
After the DataStation is configured, it will automatically col-
lect data from Em50R loggers within range and sharing the
same channel and sub channel.  After data is collected, you can
retrieve the data for permanent storage and analysis.  DataTrac
is best suited for this application.  

To download and view data from the DataStation, start
DataTrac.  In the DataTrac menu, pick the DataStation you
want to connect to and click “connect.”  Click the “Download
New Data” button. The Downloading DataStation Data screen
will appear and provides a progress bar displaying the down-
load progress.

Data Processing
DataTrac automatically sorts the data collected by the DataSta-
tion and associates the data with the correct logger.  However,
unless you used DataTrac to also configure your Em50R log-
gers, DataTrac will not know your logger’s name and which
sensors are plugged into each port.  To add this information to
your data set, click on the appropriate Em50R in the logger tree
and select “Configure.”
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If DataTrac is not an option, ECH2O Utility can be used to
retrieve data from your DataStation.  ECH2O Utility gives you
several choices for the file type when downloading data from a
DataStation. See Chapter 5: Using ECH2O Utility, for more
information. If you choose processed or raw data file formats,
ECH2O Utility walks you through processing the data for each
logger it recorded data for. It prompts you for the logger type
and sensor types for each logger. This information is necessary
for ECH2O Utility to process the data correctly.
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7. Compatible Sensors  

The Em50 logger is only compatible with sensors made by
Decagon. This chapter gives a list of compatible sensors.  To
learn more about individual sensors and their respective caliba-
rations, please visit http://www.decagon.com/support/sensor-
calibration-master-list.

Soil Water Content Sensors
10HS, EC-5 High Frequency Soil Moisture
5TM Soil Moisture and Soil Temperature
5TE, GS3, RS3 Soil Moisture, Soil Temperature, Soil EC

Soil Water Potential Sensor
MPS-2 Water Potential and Temperature Sensor

Leaf Wetness Sensor
LWS Leaf Wetness Sensor

Temperature Sensors
ECT Air Temperature Sensor
RT-1 Rugged Soil Temperature Sensor

Rain Gauges Sensors
ECRN-50 Low Resolution Rain Gauge
ECRN-100 High Resolution Rain Gauge
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Temperature and Relative Humidity Sensor
EHT Temperature/RH Sensor

Radiation Sensors
PYR Solar Radiation Sensor
QSO-S PAR Photon Flux Sensor

Wind Sensor
Davis Cup Anemometer

Deep Drainage Sensors
G1/G2 Drain Gauge

Irrigation Switch
PS-1 Pressure Switch 

Miscellaneous Sensors
ECRN-50 Volume
Millivolt (0-3000 mv input)
Millivolt (0-1500 mv input)
Pulse Counter
Flow Meter

Discontinued Sensors
EC-10, EC-20 Classic Soil Moisture 
EC-TM Soil Moisture and Temperature
ECH2O-TE Soil Moisture, Soil Temperature, Soil EC
MPS-1 Dielectric Water Potential Sensor
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8. Caring for the Em50 

Replacing the Batteries
If installed correctly, the Em50 requires little maintenance. The
main requirement is that batteries need to be replaced when
their charge becomes too low. When the battery life indicator
in ECH2O Utility shows your Em50’s batteries are less than
5%, you need to replace them.

NOTE: Installing or changing the batteries in your Em50
resets the internal real-time clock. You must connect to your
Em50 using any ECH2O system software to reset the logger’s
clock immediately after changing the batteries. If you don’t set
the logger’s clock, the time and date associated with each mea-
surement will be incorrect.

Long-Term Maintenance 
When caring for the Em50 over an extended period of time, be
sure to do the following periodically:

1. Check the battery holders and make sure they are clean and
free of corrosion.

2. Check that the sensor ports are clean, and that the sensors
are making good contact with the ports.

3. Check case gaskets and sensor cable strain relief. 
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9. Troubleshooting 

Although the Em50 has been designed for durability and built
to the highest manufacturing standards, problems may occa-
sionally occur. This chapter details the most common problems
that you may encounter, and their solutions. If you have a prob-
lem not described here or that this section cannot remedy, con-
tact Decagon at 1-800-755-2751 or email us at
support@decagon.com. 

Troubleshooting Serial Ports
PROBLEM: The ECH2O Utility tells me the communication
port I want to use is in use by another application, but I don’t
think any other programs are running. 

SOLUTION:  Some PDA synchronization programs monitor
serial communication ports. Disable Microsoft’s ActiveSync or
Palm’s HotSync system software while trying to use the serial
port with the ECH2O Utility. 

PROBLEM : My USB to Serial adapter is not showing in the
communication port picker. 

SOLUTION:  Enable “Force find all Communication Ports” in
the Preferences Menu by going to the Edit Menu, clicking
Preferences, then the Communication tab, and enabling the
check box at the bottom of the screen. Enabling this option
may find other serial ports that are not available for use by the
ECH2O Utility (for example, modems installed in your com-
puter). 
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Troubleshooting DirectConnection

PROBLEM:  ECH2O Utility tells me it can’t connect to my
device.

SOLUTION:  Try one or more of the following to make sure
there is a connection to the ECH2O device:

If you are using the accompanying USB cable, download the
USB driver from www.decagon.com/support/downloads.
Check your serial port choice. Make sure the “Connect Via”
drop-down menu shows the name of the serial port you are
using to physically connect to your logger or DataStation. For
example, if our logger is physically connected to COM1, the
“Connect Via” control should be set to “Direct on COM1 Com-
munication Port”.

Check that your serial cable is securely plugged into your log-
ger or DataStation and your Computer.

Make sure your logger has good batteries or your DataStation
is plugged in. Try pressing the reset button on your logger or
DataStation.

NOTE:  Serial Cables can fail. If you suspect your serial cable
may be the problem, try connecting to a second logger. If you
can connect, the problem is probably the first logger. If you
can’t connect to the second logger either, the problem may be
your cable. Try using a spare Decagon Serial Cable Adapter or
the USB cable if you are having trouble connecting to a logger.
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PROBLEM : ECH2O Utility keeps reporting it lost the connec-
tion to my device.

SOLUTION:  This rarely happens for a direct connection.
Please check or replace your serial cables. You can also
increase the number of times ECH2O Utility tries sending com-
mands to the logger or DataStation. Increase the Direct Con-
nect Retries on the Communication tab of the Preferences
form.

Troubleshooting Radio Connections

PROBLEM: ECH2O Utility tells me my radio modem isn’t
responding.

SOLUTION: Make sure your serial cable is securely attached
to your computer and your Rm1. Your Rm1 should have power
and be turned on.

PROBLEM: ECH2O Utility tells me it can’t connect to my
radio logger when I’m using an Rm1.

SOLUTION:  Try one or more of the following to make sure
there is a good radio connection to your remote logger:

• Make sure your DataStation and Em50R have the same
Channel and Subchannel and that the DataStation is
being continuously powered.

• Make sure you are within radio range of the remote log-
ger by performing a telemetry test.  If this is the problem,
increase the radio signal strength to your logger by mov-
ing closer to your logger or using a high-gain antenna to
see if you can establish a radio connection.
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• Make sure the antenna on the logger and the Rm1 are
securely fastened to the radio module.

• Check the Radio Channel and the Radio Sub Channel
settings you are using on your remote loggers and Rm1.
See Chapter 7, Connecting via a Radio Modem, for how
to configure your radio settings.

• Make sure you wait ten minutes between connection
attempts for the same logger. If you just disconnected
from a logger, you must wait for ten minutes before that
logger will accept radio connections (you can always
direct connect to your logger).

• Make sure your logger has good batteries. Try pressing
the reset button on your logger.

PROBLEM:  ECH2O Utility keeps reporting it lost the con-
nection to my device.

SOLUTION:  This can happen when the radio connection is
lost. Try increasing the radio signal strength by moving closer
to the remote logger or using a high-gain antenna. You can also
increase the number of times ECH2O Utility tries sending com-
mands to the logger. Increase the Radio Connect Retries in the
Communications tab on the Preferences form.

Troubleshooting Data Issues

PROBLEM: ECH2O Utility tells me there is no new data for
downloading.

SOLUTION: Make sure the logger is configured to measure
data. Make sure the measurement interval is set to a number
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greater than zero. Try pressing the reset button if the logger
does have a non-zero measurement interval.

PROBLEM: My sensor data shows “* * *” in the Scan window.

SOLUTION: The three asterisks mean the raw data measured
by the logger is out of expected range for the sensor. This could
be caused by a broken sensor. Make sure the sensor is fully
inserted into the logger’s sensor port. Make sure the sensor
type shown in the Scan window matches the sensor actually
connected to your logger.

PROBLEM: My sensor data doesn’t seem to be correct.

SOLUTION: There are many issues that affect the quality of
the sensor measurement. Please see the user manual of your
particular sensor for help troubleshooting the data collected by
your sensor or contact Decagon by phone at 1-800-755-2751 or
by email at support@Decagon.com.

Troubleshooting Logger Issues

PROBLEM: My logger stopped making measurements.

SOLUTION:  Make sure the measurement interval is not set to
0. The Em50 does not make any measurements when the mea-
surement interval is set to zero.

Try pushing the reset button. Try initializing your Em50 if a
reset isn’t enough to get the logger measuring sensors again.
Connect to the logger and choose “Initialize Device...” from
the Device Tools sub-menu in the Actions menu. Initializing
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your Em50 will erase any stored data so you should download
any data you want to keep before choosing this option.

PROBLEM : My logger doesn’t seem to be working correctly
or reliably.

SOLUTION : Try pressing the reset button on the logger. This
resets the logger’s firmware. You can also try connecting to the
logger and testing the integrity of the firmware. Choose “Test
Device Firmware” from the Device Tools menu of the Actions
menu. Contact Decagon for help reloading the firmware if
ECH2O Utility reports the device firmware is corrupt. If the
firmware tests good and your logger is still not working cor-
rectly, please contact Decagon for repair or replacement.
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Appendix A:

Em50 CE Compliance  

Application of Council Directive: 89/336/EEC

Standards to Which EN61326 : 1998
Conformity is Declared: EN55022 : 1998

Manufacturer’s Name: Decagon Devices, Inc.
       2365 NE Hopins Ct.

Pullman,WA99163

Type of Equipment: Data collection system

Model Number: Em50

Year of First Manufacture: 2002

This is to certify that the Em50, manufactured by Decagon
Devices, Inc., a corporation based in Pullman, Washington,
USA meets or exceeds the standards for CE compliance as per
the Council Directives noted above. All instruments are built at
the factory at Decagon and pertinent testing documentation is
freely available for verification.   
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Em50R/DataStation/Rm1 CE Compliance

Application of Council Directive: 89/336/EEC

Standards to Which EN61326 : 1998
Conformity is Declared: EN55022 : 1998

Manufacturer’s Name: Decagon Devices, Inc.
2365 NE Hopkins Ct.
Pullman, WA 99163

Type of Equipment:         Data collection system

Model Number: Em50R 2.4 GHz
Rm1 2.4 GHz,
DataStation 2.4 GHz

Year of First Manufacture:           2002

Restrictions:
France: Current regulations in France stipulate that these
devices may be used indoors only. Outdoor use on private
property is subject to authorization from the French Telecom-
munications Regulatory Authority. Outdoor use on public
property is currently prohibited. For more information, see
www.ero.dk.
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FCC Compliance

The following FCC statement applies to the Em50, Em50R,
Em50G,  DataStation, and Rm1.
This device complies with part 15 of the FCC Rules. Operation
is subject to the following conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, includ-
ing interference that may cause undesired operation.

The Em50R, DataStation, and Rm1 contain one of the follow-
ing modules:

FCC ID: OUR9XSTREAM  IC: 4214A-9XSTREAM
FCC ID: OUR-24XSTREAM  IC: 4214A 12008

The Em50G contains the following module:

FCC ID: IHDT56HQ1  IC: 109O-HQ1

Information for users
Changes or modifications to the EM50 series loggers not
expressly approved by Decagon Devices, Inc. could void FCC
compliance and thus the user's authority to operate the equip-
ment.

NOTE: This equipment has been tested and found to comply
with the limits for a Class B digital device, pursuant to Part 15
of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate
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radio frequency energy and, if not installed and used in accor-
dance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or televi-
sion reception, which can be determined by turning the equip-
ment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and
receiver.

• Connect the equipment into an outlet on a circuit differ-
ent from that to which the receiver is connected.

• Consult Decagon Devices or your local representative
for support.
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Em50G CE Compliance  

Application of Council Directive:  89/336/EEC
   1999/5/EC                           

Standards to Which EN61326 : 1998
Conformity is Declared:      EN55022 : 1998

Manufacturer’s Name: Decagon Devices, Inc.
2365 NE Hopkin
Pullman, WA 99163

Type of Equipment:   Data collection system

Model Number:            Em50G
 

Year of First Manufacture:           2010

Cellular Module Information
The Quad-band GSM/GPRS cellular module in the Em50G has
been tested and approved under the standards and regulations
listed below:

FCC part 12,22,24.  FCC ID: IHDT56HQ1
Industry Canada (IC) 109O-HQ1
R&TTE - LVD 2006/95/EC
      Standards: EN301 489-1 & 7, EN60950
EU Product Approval Number: G24-L
GCF 3.27.1
NAPRD 3.14.0
PTCRB
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Appendix B:

Send Feedback to Decagon

Decagon Software makes it easy to send feedback, bug reports,
and feature requests to Decagon or your Decagon Distributor.
Choose “Send Feedback to Decagon...” from the help menu.
This opens the window shown below.

Enter your name, company name, and other contact informa-
tion. Tell us what type of feedback you are sending (General
Feedback, Feature Suggestions, Bug Report, or Other). Indi-
cate how you want us to respond to your feedback (Email or
Telephone).
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Use the description area to give details for your feedback. If
you are reporting a bug, it is very helpful for you to tell us what
steps you took for the bug to happen and any error message
you saw. By default, bug reports also include the software error
files.

You can send Decagon a file using this form too. This is useful
for sending data files that you have questions about.

If you work directly with a Decagon representative, put their
E-mail address in the field at the bottom of the form. This
sends the contents of the form to them. Your Decagon repre-
sentative can follow-up with you directly.
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Appendix C:

Em50G User License Agreement  

1. CONTRACT FORMATION 
The use of the Em50G (“Device”) is governed by the terms and
conditions set forth herein.  Please read these terms and condi-
tions carefully.  If you use or activate the equipment you agree
to be bound by these terms and conditions.  If you do not
accept and agree to be legally bound by these terms and condi-
tions, please do not use the equipment.  If you choose not to
accept these terms and conditions you may return the Em50G
along with all original packaging and accessories for a refund
of the purchase price less the cost of shipping and handling.  

2. WIRELESS CONNECTIVITY 
Decagon provides wireless connectivity for your EM50G for
uploading of measurement data and logger status information-
under a reseller licensing agreement.  You will be charged a fee
for wireless connectivity for your use of wireless services on
your Device.  Decagon reserves the right to discontinue wire-
less connectivity at any time or to otherwise change the terms
for wireless connectivity at any time, including, but not limited
to (a) limiting the frequency and amount of data that may be
transferred using wireless connectivity and (b) changing the
amount and terms applicable for wireless connectivity charges.

3. COVERAGE AND SERVICE INTERRUPTIONS
You acknowledge that if your Device is located in any area
without applicable wireless connectivity, you may not be able
to use some or all elements of the wireless services. Decagon is
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not responsible for the unavailability of wireless service or any
interruptions of wireless connectivity.

4. YOUR CONDUCT
You agree you will use the wireless connectivity provided by
Decagon only in connection with services Decagon provides
for the Em50G. You may not use the wireless connectivity for
any other purpose.  Unless specifically indicated otherwise,
you may not sell, rent, lease, distribute, broadcast, sublicense
or otherwise assign any rights to wireless services.  You may
use the Em50G Software only on the Em50G. You may not
sell, rent, lease, lend, distribute or sublicense or otherwise
assign any rights to the Software in whole or in part.  You may
not, and you will not encourage, assist or authorize any other
person to, modify, reverse engineer, decompile or disassemble
the Em50G or the Software, whether in whole or in part, create
any derivative works from or of the Software, or bypass, mod-
ify, defeat or tamper with or circumvent any of the functions or
protections of the Em50G or Software. 

5. AUTOMATIC UPDATES
In order to keep your Software up-to-date, Decagon may auto-
matically provide your Device with updates/upgrades to the
Software.

6. EXPORT REGULATIONS
You agree to comply with all export and re-export restrictions
and regulations of the Department of Commerce and other
United States agencies and authorities, and not to transfer, or
encourage, assist or authorize the transfer of the Software to a
prohibited country or otherwise in violation of any such restric-
tions or regulations.
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7. GOVERNMENT END USERS
The Software is a “Commercial item” as that term is defined at
48 C.F.R. §2.101, consisting of "Commercial Computer Soft-
ware" and "Commercial Computer Software Documentation,"
as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R.
§227.7202, as applicable. Consistent with these provisions, the
Software is being licensed to U.S. Government end users (a)
only as a Commercial item and (b) with only those rights as are
granted to all other end users pursuant to the terms and condi-
tions of this Agreement.

8. NO ILLEGAL USE & RESERVATION OF RIGHTS
You may not use the Em50G, or the software for any illegal
purpose. You acknowledge that the sale of the Em50G to you
does not transfer to you title to or ownership of any intellectual
property rights of Decagon or its suppliers. All of the Software
is licensed, not sold, and such license is non-exclusive.

9. DATA STORAGE
The Em50G and Software will provide Decagon with data
about your Device and its interaction with the software and
information related to the content on your Em50G may be
stored on servers in the United States at Decagon headquarters.
You agree to assume sole responsibility to backup and store
your data collected by the Em50G and Software.  

10. Data Security and Privacy
While the Em50G and Software use cryptographic methods to
protect the integrity of data transfers, Decagon does not guar-
antee privacy of measurement data or Device status informa-
tion collected and transferred by the Em50G. You are solely
responsible for the security of the Device access passwords
issued to you by Decagon. 



Em50/Em50R/Em50G Operator’s Manual
Appendix C:

82

11. PATENTS
The Em50G and/or software used in association with the
Em50G may be covered by one or more patents or pending
patent applications, and/or copyright and trademarks or pend-
ing applications.  

12. TERMINATION
Your rights under this Agreement will automatically terminate
without notice from Decagon if you fail to comply with any
term of this Agreement. In case of such termination, you must
cease all use of the Software and Decagon may immediately
revoke your access to the Service or to Digital Content without
notice to you and without refund of any fees. Decagon’s failure
to insist upon or enforce your strict compliance with this
Agreement will not constitute a waiver of any of its rights.
You may terminate the service at any time, but you will be
responsible for all payments under the data services through
the end of the term. 

13. DISCLAIMER OF WARRANTIES
YOU EXPRESSLY ACKNOWLEDGE  AND AGREE THAT  USE OF

THE  EM50G, SOFTWARE AND DATA  STORAGE IS AT  YOUR

SOLE RISK . EXCEPT FOR THE ONE-YEAR LIMITED WARRANTY,
THE  EM50G, SOFTWARE AND DATA  STORAGE ARE PROVIDED

“ AS IS” WITH  ALL  FAULTS  AND WITHOUT  WARRANTY  OF

ANY  KIND  AND DECAGON AND ITS SUPPLIERS AND LICEN -
SORS DISCLAIM  ALL  WARRANTIES , EXPRESS OR IMPLIED ,
INCLUDING , BUT NOT LIMITED  TO, THE  IMPLIED  WARRAN -
TIES OF MERCHANTABILITY , FITNESS FOR A PARTICULAR

PURPOSE, ACCURACY , QUIET  ENJOYMENT  AND NON-
INFRINGEMENT  OF THIRD -PARTY  RIGHTS . NO ORAL  OR

WRITTEN  INFORMATION  OR ADVICE  GIVEN  BY DECAGON OR

AN AUTHORIZED  REPRESENTATIVE  OF DECAGON SHALL  CRE-
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ATE  A WARRANTY . THE  LAWS  OF CERTAIN  JURISDICTIONS

DO NOT ALLOW  THE  DISCLAIMER  OF IMPLIED  WARRANTIES . 

14.  LIMITATION OF LIABILITY 
L IMITATION  OF LIABILITY  TO THE  EXTENT  NOT PROHIBITED

BY LAW , NEITHER  DECAGON NOR ITS SUPPLIERS OR LICEN -
SORS SHALL  BE LIABLE  TO YOU FOR ANY  INCIDENTAL  OR

CONSEQUENTIAL  DAMAGES FOR BREACH  OF ANY EXPRESS

OR IMPLIED  WARRANTY , BREACH  OF CONTRACT , NEGLI -
GENCE, STRICT  LIABILITY  OR ANY  OTHER LEGAL  THEORY

RELATED  TO THE  EM50G, SOFTWARE AND DATA  STORAGE,
INCLUDING , BUT NOT LIMITED  TO, ANY DAMAGES  ARISING

OUT OF LOSS OF PROFITS, REVENUE, DATA  OR USE OF THE

EM50G OR SOFTWARE OR ANY ASSOCIATED PRODUCT, EVEN

IF DECAGON HAS BEEN ADVISED  OF THE  POSSIBILITY  OF

SUCH DAMAGES. IN ANY  CASE, DECAGON'S AGGREGATE  LIA -
BILITY  UNDER THIS  AGREEMENT  SHALL  BE LIMITED  TO THE

AMOUNT  ACTUALLY  PAID FOR THE  DEVICE . THE  LAWS  OF

CERTAIN  JURISDICTIONS  DO NOT ALLOW  THE  EXCLUSION  OR

LIMITATION  OF INCIDENTAL  OR CONSEQUENTIAL  DAMAGES . 

15. WASHINGTON LAW APPLIES
The laws of the state of Washington, without regard to princi-
ples of conflict of laws, will govern this Agreement and any
dispute of any sort that might arise between you and Decagon.

16. DISPUTE RESOLUTION
By using the Em50G you agree to jurisdiction and venue of
any dispute arising out of this agreement by the Whitman
County Court unless the parties agree to a different dispute res-
olution process in writing.  
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17. SEVERABILITY
If any term or condition of this Agreement shall be deemed
invalid, void, or for any reason unenforceable, that part shall be
deemed severable and shall not affect the validity and enforce-
ability of any remaining term or condition.

18. AMENDMENT
Decagon reserves the right to amend any of the terms of this
Agreement at its sole discretion by sending an amended agree-
ment in writing to you by first class mail or email.   Your con-
tinued use of the Device and Software after the effective date
of any such amendment shall be deemed your agreement to be
bound by such amendment.
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